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Contact and Support Information

Return to Table of Contents.

Product information can be accessed by visiting Customer Support online: CCH Axcess Product Support.

In addition to product and account information, the Customer Support site offers answers to our most
frequently asked questions, forms release status, Knowledge Base articles, training videos, and operating
systems compatibility for each CCH Axcess™ module. Access to these features is available 24/7.

The following Web site provides important information about the features and updates included in all CCH
Axcess Tax releases: Release Notes.

Visit the Application Status Web page to view the current status of our CCH Axcess applications. The
Application Status Web page is updated every 15 minutes.

Go to Contact Us to find Support calendars, as well as options to enter Web tickets for assistance.
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Information in Tax Release Notes

Return to Table of Contents.

CCH Axcess™ Tax Release Notes inform you of the enhancements and updates that were made to Tax
products and systems with the current release.

Information provided in the Release Notes include the following:

& (Contact and Support information

B Updates to Tax technology (such as, electronic filing updates, Organizer, Pro Forma/roll
forward, and technology enhancements)

® Updates made to Tax products (such as, form additions and updates, changes in diagnostics,
and changes caused by regulatory updates)

To access a list of CCH Axcess™ Tax Release Notes for the current year and for prior years, visit the Release
Notes page on our Customer Support site.
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Highlights for Release 2016-1.0
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Tax Updates

Link to Supporting Statements

In Tax Forms view, "see statement” links will now display on any line with a supporting statement. The links
allow you to click on a link and quickly view the statement related to that particular line in a new window.

Note: This feature will include a print button, just like Elections has now.

New Vendor Control Numbers (VCN) Numbers for Electronic Filing

We will create a new Vendor Control Number (VCN) for each of your EFINs. VCNs will be available now for
Tax customers who electronically filed a 2015 return prior to December 1st. New Tax customers who have
submitted their eServices EFIN application will be provided a VCN on January 8, 2017. Any eServices EFIN
applications submitted after January 8th will be processed and a VCN provided within 48 hours.

You may locate your VCN within the Electronic Filing Status System by selecting Admin, located to the right
of your name, then Vendor Control Numbers. The VCN must be entered in Configuration > Return
Configuration Sets > Tax Return Configuration Set Name > Electronic Filing Options > General.

Return Configuration Sets

B We added the following options:
¥ Vendor control number (all systems)

¥ Do not prepare separate letters for certain federal forms to the letters options (certain
1040 and business federal forms)

¥ Electronically file estimates tax payments (1041 and 1065)

¥ Print IRS mailing address on federal estimates vouchers (1040 and 1041)
¥ Print IRS mailing address on federal extensions (all systems)

¥ Always produce 8879-SO during export (1041, 1065, 1120, 1120S, 990)

Notes:

® |f your firm is using My1040Data for the first time, we recommend that you start with a subset
of your clients to ensure that there are no surprises and to confirm that it fits your workflow
expectations.

B No action is required to use My1040Data; there is no license fee or transactional charge for
using My1040Data.

® For more information and detailed instructions, enter the Toolkit and go to the Help link at the
bottom of any page.

® Visit our CCHGroup.com web page for more My1040Data product information.
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Electronic Filing Status System®
We added the following enhancements:

® New design. We redesigned the user interface in HTML and removed the dependency on
Silverlight.

® Customization of columns. As many users were unaware of the ability to customize grid
columns, we changed the label for this feature to “Select Columns.” You can add columns to
the grid, such as Bank Info, Elec Debit/Deposit, Elec Debit/Deposit Amt, FBAR, and FBAR Date.
Refer to Help in the Electronic Filing Status System for a complete list of available columns.

B Return history. Reject detail is now display in the Return History window, even after the
status has changed (for example, changed to paper filed) or the return has been resubmitted
and accepted.

B Grid export. We have greatly enhanced grid export:
¥ Grid contents now opens in a Microsoft® Excel® file with filters already set on each
column.
¥ You can export all data in the grid without limitation.

Fast Forms

New for 2016 is a process to update government forms with the Approval Pending watermark. We will now
make available forms that have been approved by government agencies without having to wait for a release
to post. This process will update forms and remove the Approval Pending watermark automatically.

Common Data

The values from the Fiduciary name and Fiduciary title fields in the client profile flow to the respective
fields in the 1041 return.

IRS Fraud Prevention Initiatives

As part of the Internal Revenue Service, state tax agencies and private-sector industry Security Summit
partnership, taxpayer and tax return preparer safeguards will be implemented for the upcoming 2017 filing
season. The Security Summit Partners initiatives will enhance authentication efforts of tax return preparers
via new requirements.

® New Vendor Control Number (VCN) required for electronic filing
® Require vendors to collect and retain all customer EFIN letters
B New driver’s license/state ID requirements for electronic filing

CCH Axcess Authentication Changes Resulting From the IRS/State Requirements

B Passwords.

¥ A strong password with eight characters minimum, including an uppercase, a lowercase,
a special character, and a number is required.

¥ You must reset your password at a maximum of every 30 to 90 days.

B 30 minute timeout. You are prompted to log back in at a maximum of 20 to 30 inactive
minutes.

Highlights for Release 2016-1.0 « 5



B 24 hour re-authentication. You are prompted to re-authenticate your credentials after 24
hours, regardless of activity.

® Bot detection. You must enter CAPTCHA text with each log in.

For more information, see our Knowledge Base article.

Pro Forma/Roll Forward

Additional fraud prevention measures from the states restrict transferring certain data:

® Driver’s license information
& State withholding IDs
® Banking information for Arkansas, District of Columbia, Illinois, Oregon, Virginia

Note: Preparer Notes for each return affected are available to explain the handling of this
data.

Electronic Filing Changes
New driver’s license/state ID requirements are in place for e-filing.

Please be advised that due to new state data requirements aimed at fraud prevention, state electronically
filed returns require new data/fields not previously required.

You will only be allowed to e-file state extensions if this required data is included in the electronic file; this
includes our Electronically Filed Batch Extension program.

We have included all possible fields from the prior year return, but the following elements are new and you
must enter these fields in each applicable tax return prior to e-filing:

® |ndividual. Driver's license/state ID number and driver's license/state ID expiration date
® Fiduciary. Officer ID number

® Partnership. Officer ID number

& Corporation. Officer ID number

& S Corporation.Officer ID number

Federal e-filed returns, including federal electronically filed batch extensions are unaffected by the new
requirements. Processing federal e- filed extensions in batch remains unchanged.

CCH® My1040Data

My1040Data is an online tax organizer that makes it easy for clients to provide their personal information
and tax return-related documentation to tax preparers by concentrating on:

B |nteractive questions

® Collecting source document attachments

® Minimizing data entry
Tax preparers create Organizers for Pro Forma and new clients with My1040Data Toolkit to assist in
gathering the information necessary to prepare Individual tax returns. After sending a My1040Data link to

your clients, you can use the Toolkit to monitor, track, and view the contents of each client's My1040Data
Organizer.

You can access My1040Data Toolkit from the Application Links window in Dashboard.
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After clients attach source documents and enter other information in My1040Data, the most efficient way to
organize and transfer this information to the tax return is with CCH® ProSystem fx® Scan and AutoFlow.
PDFlyer can prepare the My1040Data Organizer and any PDF files received for processing by Scan without
having to print them.

Tax Notebook and Tax Notebook Toolkit

Tax Notebook Toolkit is now available for processing and for creating Tax Notebooks.

CCH® eSign

For tax year 2016, Maryland is added to the list of states that allow electronic signatures on authorization
forms.

All Systems Updates

Banking “Confirm” Option

This option is now required for all electronic filing returns. Previously it would only disqualify if the return
results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate bank
account information.

Depreciation Detail Reports

B Removed the Portrait and Large Font Depreciation Detail reports.
B Retained the “Small Font” Depreciation Detail reports and renamed them Depreciation Detail.

Gains

® Added a column in Worksheet View for "Quantity,” right after the "Description” column. Allows
you to import and export the number of shares from a Microsoft® Excel® file.

® Put the number back in the description field to display on the tax form.

Multiple Return Types Updates

B Reorganized electronic filing items and created consistency across return types.

B Froze the Asset Description in place when scrolling on worksheet view summary grids
(1040,1041,1120, 1120S, 1065, 990).

B |ncreased the Depreciation Department Number from 2 to 4 characters (1040, 1041, 1120,
1120S, 1065, 990).

® Depreciation pro forma - the Excess IDC for a depletion property now creates a new asset.
Added the 8879-S0 (state only) for states without a signature form (1041, 1120, 1120S, 1065).

® Added Form 1128, Application to Adopt, Change, or Retain a Tax Year (1120, 1120S, 1065).

® Added a Selective K-1 suppression option to suppress partner/shareholder by
partner/shareholder (1065, 1120S).

B Added separate filing instructions and transmittal letters for these items to be used in future
print packages - 2848, 8879, 3520, and 3115 (1041, 1120, 1120S, 1065).
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Now prints “Mail To:” and the mailing address at the bottom of extensions (7004, 8868) if the
return is not selected for electronic filing (1120, 1120S, 1065, 990).

Adjusted all letters and forms for the new Federal due dates for regular and extended returns.
Affects all returns (except 1120S and 1040) and includes states.

“Extensions” was moved from the “Other” category to its own category; this will now be the
second item on the Worksheet View menu.

To be consistent, moved Electronic filing statement codes from the electronic filing worksheet
to the specific form (1120, 1120S, 1065).
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Tax Product Enhancements

Click any of the links below to read about the tax application enhancements included with release 2016-1.0.

Individual (1040) Product Enhancements

Partnership (1065) Product Enhancements

Corporation (1120) Product Enhancements

S Corporation (1120S) Product Enhancements

Fiduciary (1041) Product Enhancements

Exempt (990) Product Enhancements
Estate and Gift (706/709) Product Enhancements
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Individual (1040) Product Enhancements

Return to Table of Contents.

Federal

Depreciation Detail Reports

We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font” Depreciation
Detail reports remain and are renamed Depreciation Detail.

Banking “Confirm” Option

This option is now required for all electronic filing returns. Previously it would only disqualify if the return
results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate bank
account information.

IRS Fraud Prevention

An ID type field is now available to indicate driver’s license or state issued ID.

Federal Links Worksheet

We added “Autoflow” and "Date Calculated” to the worksheet to be easily used in the DataScans created
(Summer 2016).

Amortization Report

We added a new amortization report for 1040 (already available for business systems).

Wages Statement

The wages statement now includes a statement reference number on Form 1040, Line 7. Previously, no
statement reference printed (Summer 2016).

Expatriate Wages

We added fields for work days/hours in city as well as dates worked to properly flow to the city returns.

Gains
B We added a column for "Quantity” after the "Description” column. This allows you to import and
export the number of shares from a Microsoft® Excel® file. We will put the number back in the
description field on the tax form.
B We added fields for state ID numbers.
Miscellaneous

B We reorganized electronic filing and created consistency across systems.
B Asset Description is static for summary grid scrolling purposes.
® Depreciation Department Number is now four characters (was two).
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Letters

B We added separate filing instructions and transmittal letters for these items to be used in future
print packages - 114, 2848, 8879, 3520, and 3115.

B We added a new sentence to refer the reader to the Direct Deposit/Debit Report if that report
is included in the return.
Extensions

We moved the “Extension” section to its own category; which is now the second item on the menu.

New Drill Downs
We added drill downs for:

B Page 1 Line 10, Taxable refunds, credits, or offsets of state and local income taxes

® Page 1 Line 21, Other Income - as this line can have items that come from many different
entries

® Page 1 Line 44, Tax
® Form 6251, Line 27, Other adjustments, including income-based related adjustments

Consistency/Usability Initiative Changes

We added IRS Form names to menu for search ability.

B We revised the menu for logic and consistency.

® We moved Extension in the menu to second after General.

B We added summary grids to State Estimate Payment and State Extension Payment sections.

Worksheet Navigation

B We broke up income and deductions into separate sections.
B We added Social Security income as its own node at the same level as Other Income.

1040NR, U.S. Nonresident Alien Income Tax Return

B We added e-file (which entails input and output changes to Form 1040NR, Form 8840, and Form
8843).

® We added a check box that when checked will add the text “Not present in U.S. -No U.S.
immigration status” to Page 5, Line E, Immigration Status. Per the IRS, this is the required text
if the taxpayer was not present in the United States on the last day of the tax year, and has no
U.S. immigration status.

New Forms

B Form 8854, Initial and Annual Expatriation Statement
# Added with limited calculations only
¥ Includes electronic filing
® Form 8830, Enhanced Oil Recovery Credit
® Form 8974, Qualified Small Business Payroll Tax Credit for Increasing Research Activities
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Supporting Statement

We now provide a statement for Line 65, 20xx estimated tax payments and amount applied form 20xx return
(prior year return) (1040 and 1040NR).

Revised Footer

When there is a statement for interest and penalties, text will print at the bottom of Form 1040, Page 2. It
will indicate the total amount due, including interest and penalties.

Revised Forms

® Form 8867. Paid Preparer's Earned Income Credit Checklist is revised and renamed. The
changes are a result of the expansion of paid preparer's due diligence requirements to cover the
Child Tax Credit, the American Opportunity Education Credit, and the Earned Income Credit.

® Form 8958. Allocation of Tax Amounts Between Certain Individuals in Community Property
States allows you to report every W-2 source AND split each.

® Form 8965. Input from the IRS 1095-A will be used in the calculations determining total months
of coverage for the tax household.

& 1099-MISC Summary Grid. We added all possible additional income fields to the Summary Grid
for the 1099-MISC. Example - rents, royalties, and nonemployee compensation.

® Pro forma. We added the "Delete from pro forma option” for Forms 1098 Mortgage Interest
Statement and Forms 1099.

® PTP. Allows for aggregation of PTP K-1s, which will offset gains and losses from different
entities in one PTP.

B Passthroughs. We added fields for Section 59(e)(2) expenditure carryovers.

B |nvestment management fees. The description now appears as “Payer Name - Investment
Expenses” when an amount is entered in the investment expenses field on 1099-INT, 1099-DIV
and Consolidated 1099 input.

Schedule B

® Three fields are available for tax-exempt interest. The field on the IRS 1099-INT is used for the
federal return and two other fields are available for tax exempt interest that is state
nontaxable and state taxable. When an entry is made in one of the state fields, the other field
is auto-filled with the difference between the federal and state amount.

® The IRS 1099-DIV uses the same approach.

B |n response to a change by the IRS, a field is added for bond premium on Treasury obligations.
As a result, amounts of bond premium are no longer allocated to interest from Treasury
obligations.

Form 8621, Information Return by a Shareholder of a Passive Foreign Investment Company or
Qualified Electing Fund

We added the following:

B The option to code 8621 income as dual status so that it will flow to the 1040 statement.
B Additional detail input for prior year amounts on Form 8621.

B A grid to 8621 - Return by a Shareholder of a PFIC or QEF > Distributions/Dispositions from
Section 1291 Fund to allow import and export of data.
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Diagnostics

We added a diagnostic for an automatic sale when business use % is entered. This will alert you that the cost
basis will flow to Form 4797 at 100%, as opposed to some business use %. When the matching sale number is
used and "percent to be excluded” is entered for depreciation, the percent is not applied to the "cost or other
basis" of the asset.

Tax Equalization
We added the following:

® An override for US hypo wages: Foreign > Expatriate Wages > - US hypothetical Comp - override
® OQverrides for all Form 8959 lines
® Pennsylvania cities

IRS Processing Notes

® Form 8812. Returns may be filed and will be processed by the IRS when the filing season opens,
but refunds containing earned income credit (EIC) or additional child tax credit (ACTC) will not
be issued until February 15, 2017.

® Form 8885. The health coverage tax credit (HCTC) can no longer be taken for health plans
offered through a Health Insurance Marketplace. Monthly advance payments of the HCTC have
been implemented on a limited interim basis. The IRS expects to fully implement the program
in January 2017.

® Form 8941. The credit for small employer health insurance premiums may only be claimed over
two consecutive years. If the credit was claimed in 2014, it cannot be claimed for 2016.

Organizer

You can now alphabetize K-1s on Organizers. The default is to alphabetize.

States
B We added automatic Foreign Tax Credit calc to applicable states.
¥ Allow only for Canadian Province: MA, MI, MN, NY, VT
¥ Allow for foreign countries: AL, AZ, IA, IN, KS, MT, NC, NM, VA
* Allow for state, territory of US possession: CO, DC, ID, IL, MD, MS, ND, OR, UT
B We standardized automatic inclusion of nonresident state return for e-file when applicable for
resident credit for taxes paid.
B We added the ability to e-file state estimate payments for:
¥ DC, NY, NYC, TN FAE-172
B Deleting a state from a return will retain the state taxes paid for Pro Forma purposes, making
them available for next year’s Schedule A deduction.
Alabama

We added AL COA - Change of Address Form.
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Arizona

We added AZ 352, Credit for Contributions to Qualifying Foster Care Charitable Organizations. Input is on
Arizona, Credits > Contributions to Qualifying Foster Care Charitable Organizations.

Arkansas
We added the following:

® AR EST PMT, Estimated Tax Payment Bank Authorization for Direct Debit
& AR TAX PMT, Income Tax Payment Authorization for Direct Debit

California
We added the following:

& CA 8453(PMT) - Payment for Automatic Extension and Estimate Payment Authorization for
Individuals

& CA 8879(PMT) - Electronic Funds Withdrawal Payment Signature Authorization for Individuals
and Fiduciaries

® CA LLC-12NC, Statement of No Change
Direct debit of extension payments
& 2D barcode (540NR)

Colorado

B We added the following:

# 104AD, Subtractions from Income

¥ 104CH, Voluntary Contributions Schedule

¥ 104US, Consumer Use Tax Reporting Schedule
® 2D barcodes are now mandated.

Connecticut

We now flow the Property Tax from federal for Property Tax Credit purposes.

District of Columbia
We added D-40WH, Withholding Tax Schedule.

Georgia

B We added the following:
¥ (CR-207, Rural Physicians Credit
¥ (CR-208, Adoption of a Foster Child Credit
# CR-209, Eligible Single-Family Residence Tax Credit
¥ Supplemental W-2, Income Statement Details
& 2D barcode (500 and 500X) are now mandated.

Hawaii
We added N-311, Refundable Food/Excise Tax Credit.
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Indiana
We added Schedule IN K-1, Shareholder’s/Partner’s Share of AGI, Deductions, Modifications and Credits.

lowa
We added the following:

& 100A, Capital Gain Deduction - Livestock

100B, Capital Gain Deduction - Real Property, Farm
100C, Capital Gain Deduction - Real Property, NonFarm
100D, Capital Gain Deduction - Timber

100E, Capital Gain Deduction - Business

100F, Capital Gain Deduction - ESOP

Maryland
We added the following:

B 548, Power of Attorney. Input is on Federal, Power of Attorney worksheet
& 502R, Retirement Income

Massachusetts

® Returns may allow PDF attachments.
® We added M-8379, Nondebtor Spouse Claim and Allocation for Refund Due.
B We added Sch OJC, Income Tax Paid to Other Jurisdictions.

Michigan
We added 5472, Direct Debit of Individual Income Tax Payment.

Michigan - DTW
We added the following:

® Part-Year Resident Income Tax Return
® CF 1040X, Amended Individual Tax Return
® CF 1040XPV, Amended Income Tax Return Payment Voucher

Minnesota
We added the following:

B A statement on the MN return that shows how the pass through income is calculated when there
are suspended losses.

& M1REF, Refundable Credits.
B M1PSC, Credit for Parents of Stillborn Children.

Mississippi
We added 80-360, Catastrophe Savings Tax.
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Missouri - Missouri Kansas City

We added the following:

Nevada

RD-108, Payment Voucher
RD-109, Payment Voucher
Electronic filing of Forms 108 and 109

We added the Nevada Commerce Tax (Summer 2016).

New York

We added IT-639-ATT, Eligible Employee Information for the Minimum Reimbursement Credit.

New York City

We added the ability to generate multiple Declaration of Estimated Tax (vouchers 2,3, and 4).

Ohio

B We added IT/SD 2210-100 ANN INC, Annualized Income Worksheet.

Oregon

We added Separate School District Return Summaries.
We separated School District Letters/Filing Instructions.

We added the following:

40-EXT, Extension of Time to File and Voucher

Schedule OR-ADD-DEP, Additional Dependents

Diagnostic alerting the possibility of using OR-PTE
Calculation of Special Medical Subtraction from FD numbers
Automatic carryforwards of prior year credits

Oregon - MUL

We added electronic filing.

Pennsylvania

We removed RCT-101 forms.

® We added PA-40 Sch P, Refund Donations to 529 College Savings Program Accounts.
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Pennsylvania - Pennsylvania Cities
We added TEQ.

Pennsylvania - Philadelphia

B We added electronic filing for Form S1.
B We pulled Expat wages to Form AR/WTR.
& We added TEQ.

Tennessee
We added the following:

® RV-F1307901 (Certification), Franchise and Excise Tax Exemption
® FAE 172 and EF
® 2D barcode

Texas
We added 05-158-B FINAL, Franchise Tax Report.

Vermont

We added EF extensions.

Wisconsin
We added the following:

® Schedule BD, Business Development Credit
B Schedule Ql, Sale of Investment in a Qualified WI Business
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Partnership (1065) Product Enhancements

Return to Table of Contents.

Federal

Depreciation Detail Reports

We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font” Depreciation
Detail reports remain and are renamed Depreciation Detail.

Banking “Confirm” Option

This option is now required for all electronic filing returns. Previously it would only disqualify if the return
results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate bank
account information (Summer 2016).

Federal Links Worksheet

We added "Date Calculated” to the worksheet to be easily used in the DataScans created.

Schedule K-1

We added the option to suppress Schedule K-1 on a Partner by Partner basis.
We added ratio ID Numbers to Passthrough Input for Allocations.

® We added an option to Prepare Simplified Increase/Decrease Reconciliation Statement for
Schedule K-1, Item L.

® We added an open line item input for Line 13R, Pensions and IRAs.

Apportionment

We added a Zero Apportionment option for state and city returns.

Gains

We added a column for "Quantity” after the "Description” column. This allows you to import and export the
number of shares from a Microsoft® Excel® file. We will put the number back in the description field on the
tax form.

Miscellaneous

B We reorganized electronic filing and created consistency across systems.
B Asset Description is static for summary grid scrolling purposes.

® Depreciation Department Number is now four characters (was two).

B | etters:

¥ We added separate filing instructions and transmittal letters for these items to be used in
future print packages - 114, 2848, and 3115.

¥ We added a new sentence to refer the reader to the Direct Deposit/Debit Report if that
report is included in the return.
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B We moved “Extensions” from the “Other” category to its own category; this is now the second
item on the menu.

® You can now print the mailing address on the bottom of federal extensions for paper filed
returns. A return configuration set option is also available.

Extensions

B We moved “Extensions” from the “Other” category to its own category; this is now the second
item on the menu.

B The mailing address now prints at the bottom of federal extensions.

Letters

B We added separate filing instructions and transmittal letters for these items to be used in future
print packages - 114, 2848, and 3115.

B We added a new sentence to refer the reader to the Direct Deposit/Debit Report if that report
is included in the return.
Consistency/Usability Initiative Changes

B We revised the menu for logic and consistency.
® We moved Extension in the menu to second after General.
B State Composite and State Adjustments categories in menus are now collapsible.

New Forms
We added the following:

® 8830, Enhanced Oil Recovery Credit
® 1128, Application to Adopt, Change or Retain a Tax Year

States

& We added the ability to e-file state estimate payments for:
Minnesota Tennessee
® We added Form 8879-S0O, State Signature Forms for:

Connecticut New Jersey
Delaware New Mexico
Idaho North Dakota
IUlinois Rhode Island
Kansas South Carolina
Maine Tennessee
Michigan Texas
Minnesota Utah

Missouri West Virginia
Nebraska Wisconsin

New Hampshire
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B We added State/City electronic filing for:
¥ (California Extensions - Stand Alone EFW Payments
# District of Columbia
¥ Nebraska
¥ North Carolina
# Oregon Tri-Met and LTD
¥ South Carolina

Arkansas

We added additional supporting statements to Arkansas Schedule K-1.

California
We added the following:

B (California Form 593, Real Estate Withholding Tax Statement

® (California Form 588, Nonresident Withholding Waiver Requests
Georgia
We added Form G-7 NRW, Nonresident Withholding Return (added Summer 2016).

Illinois

We added Crossover functionality Unitary Partnership returns (added Summer 2016).

Maine
We added Form 1099ME, Pass-Through Withholding.

New York
We added the following:

IT-241 - Claim for Clean Heating Fuel Credit

IT-242 - Credit for Conservation Easement Tax Credit

IT-634 - Empire State Jobs Retention Program Credit

IT-641 - Manufacturer's Real Property Tax Credit

IT-635 - Urban Youth Jobs Program Tax Credit

IT-646 - Employee Training Incentive Program Tax Credit

IT-636 - Beer Production Credit

IT-642 - Empire State Musical and Theatrical Production Credit

IT-603 - Claim for EZ Investment Tax Credit and EZ Employment Incentive Credit

Oklahoma
We added Form 504-C (EXT) - Application for Extension of Time to File Income Tax Return.

Nevada

We added the Nevada Commerce Tax (Summer 2016).
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Ohio
B We removed Form CAT-12.
B We added 2D barcodes.

Pennsylvania
We removed RCT-101 forms.

Rhode Island
We added 2D barcodes.

Wisconsin

® We changed Form 3 and Form 3K-1 back to portrait format.
B We added Schedule BD, Business Development Credit.
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Corporation (1120) Product Enhancements

Return to Table of Contents.

Federal

Forms 1120 Series Filing Due Date Changes

The Federal government has changed the return due dates and extended filing dates. Effective for tax years
beginning after December 31, 2015, C corporations must file by April 15 following the close of the calendar
year or the 15th day of the 4th month following the close of the fiscal year. A C corporation with a June 30
year end must file by September 15.

The extended due date is September 15 for a calendar year; April 15 for a fiscal year ending on June 30; and
the 15th day of the 10th month for all other fiscal years.

The new due dates apply to forms 1120, 1120-F, 1120-RIC, 1120-REIT, 1120-POL, 1120-SF and 1120-H.

Late Filing Penalty Changes

The minimum late filing penalties for federal returns filed more than 60 days late have been increased. The
penalty the greater of (a) $205 or (b) 100% of the tax due. This provision applies to returns filed after
12/31/2015.

Form 1120, Page 4, Schedule K

We added Line 19, “During the corporation’s tax year, did the corporation make any payments that would
require it to file Forms 1042 and 1042-S under chapter 3 or chapter 4 of the Code,” to Schedule K. The same
question is added to Form 1120-F, Page 2, Additional Information, Item BB.

Form 1120-F

Form 1120-F is now an 8 page form.

B We moved items H through M from Page 1 to Page 2.

B We added item W(2), "Is the corporation claiming treaty benefits pursuant to a Competent
Authority determination,” to Page 2.

B We moved Page 2, Section I, to Page 3 and Pages 4 through 7 are now Pages 5 through 8.

Form 1120-F, Schedule |

Use Other Returns > 1120-F > Schedule | - Interest Expense Allocation Under Regs > Summary to override the
disallowed passive interest expense and deferred passive interest expense allowed from Form 8810 reported
on Schedule I, Lines 24a and 24b respectively.

Form 8288-A and Form 8805

We added these two forms to Form 1120-F only and for e-filing requirements. In prior years, the IRS
allowed both forms as a PDF attachment. Both forms are now required in XML format.

Form 1120-RIC

We added Lines 5 through 8 to Page 2, Part |l, to compute the alternative timber gain tax. Part Il now
reports qualified timber gain on Line 4.
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Form 1128

Form 1128, Application to Adopt, Change, or Retain a Tax Year, is prepared from input on Other > 1128 >
Part I, General Information through Part Ill, Ruling Request.

Form 3800

Line 1zz on Page 3 is used to report the enhanced oil recovery credit (Form 8830). We activated Line 4i on
Page 3 for increasing research activities credit.

Form 7004

You can select the new option “Print IRS mailing address on federal extension” on Extensions > Federal
Extension > Line 22, to Print the IRS mailing address at the bottom of Form 7004. A return configuration set
option is also available.

Form 8830
We added the Enhanced Oil Recovery Credit form back to the program.

Banking “Confirm” Option

This option is now required for all electronic filing returns. Previously it would only disqualify if the return
results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate bank
account information (Summer 2016).

Schedule D, Part IV

We added Part IV to Page 2 devoted solely to timber gain tax. The qualified timber gain is calculated from
detail entries on Income/Deductions > Gain and Losses with property type “CAP,” “1231,” “1245,” or
“1250” and Schedule D Options of “20.” Use General > Basic Data > Miscellaneous Information > Qualified
timber gain - override.

Schedule D/ Form 8949
We added input for “Quantity” of shares.

Schedule M-3

We added Schedule M-3 designation codes “SL,” “AC,” and “SA” for rental and farm activities.

Schedule M-3, Part Il, Lines 1 through 8

We now produce a supporting statement for each of the Lines 1 through 8 on Part Il.

Passthrough

Passthrough open line input for Other Income and Deductions on Income/Deductions > Fiduciary Passthrough
or Partnership Passthrough > Other Income and Deductions is now available for C Corporation.
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Carryover Information Suppression

The General Carryover Data report and the Detail Carryover Schedule will be suppressed when the option to
“Suppress Pro Forma Processing” is selected on General > Return Options > Pro Forma Options > Suppress Pro
Forma processing.

Depreciation Detail Reports

We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font” Depreciation
Detail reports remain and are renamed Depreciation Detail.

Other Input Changes

B General > Basic Data > Miscellaneous Information

¥ We added the fields “Qualified timber gain - override” and “X if the corporation made
any payments that would be required it to file Forms 1042 and 1042-S under chapter 3 or
4.”

B General > Basic Data > State Information

¥  We added fields to enter 50% and 100% bonus depreciation taken in 2015 and Section 179
deduction taken in 2015. These fields are for state use only.

® General > Letter and Filing Instructions > Transmittal Letter
¥ We added the field “Do not prepare separate letters for certain federal forms.”
® General > Letters and Filing Instructions > Miscellaneous Options and Overrides
¥ We added the section “Federal Filing Address Overrides.”
B General > Depreciation and Depletion Options - Overrides

¥ We removed the fields "Code for depreciation reports: Landscape (1), Portrait (2), Small
font (3)" and "Section 179 carryover from passthrough entities” from the "Depreciation
Options" section.

B General > Electronic Filing > General
¥ We expanded and separated "General Information” into eight sections.

B Foreign > 114/8938 > Form 8938 Part Il - Asset and Foreign Stock Information
¥ We added a column for “GIIN Number.”

® Foreign > 114/8938 > 8938 Closely Held Owner Information
¥ We added the section “Ownership Information.”

® Foreign > Foreign Operations of US Corporations

¥ We added the field "Valid statement if the corporation was a specified domestic entity
required to file Form 8938."

& |ncome/Deductions > Gains and Losses
¥ We added a column for “Quantity.”
B |ncome/Deductions > Section 179/280 Recapture, 4684 ELF
¥ We added a section “4684 ELF Information.”
B |ncome/Deductions > Like-Kind Exchange > Supplemental Information 1

¥ We added "Realized and Recognized Gain in Multi-asset Exchange" to the bottom of the
form.

8 |ncome/Deductions > Domestic Production Activity Deduction other Information >
Override
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¥  We added the fields "Total cost of goods sold from all activities - All Activities” and "Total
cost of goods sold from all activities - Oil-Related Activities.”

Income/Deductions > Rent and Royalty > General
¥  We added the field "Schedule M-3 Designation Code."

Income/Deductions > Business > Other Deductions > Extraterritorial Income Exclusion
from Form 8873 > Detail

¥ We added the fields "X to Pro Forma" and "Basis for Entitlement Statement” to the bottom
of the form.

Income/Deductions > Dividends

¥ We added columns for payers address.
Income/Deductions > Farm/4835

¥ We added the field "Schedule M-3 Designation Code."
Income/Deductions > Fiduciary Passthrough

¥ We added the field "Class code” to the "Schedule K-1" page.

¥ We added the fields "Apportionable cost of goods sold - Oil-Related Activities" and
"Apportionable cost of goods sold - All Activities.”

# Section for "Other Income and Deductions” is opened to C Corporation.

¥ We added the field "Apportionable cost of goods sold"” to the State columns.
Income/Deductions > Partnership Passthrough

¥  We added the field "Class code” added to the "Schedule K-1" page.

¥ We added the fields "Apportionable cost of goods sold - Oil-Related Activities" and
"Apportionable cost of goods sold - All Activities.”

¥ Section for "Other Income and Deductions” is opened to C Corporation.

¥ We added the field "Apportionable cost of goods sold" to the State columns.

¥ The field "Comm revit/disaster area ded from RRE act” is opened to C Corporation.
Income/Deductions > Partnership Passthrough or Fiduciary Passthrough

¥ We added codes "20 - Enhanced oil recovery credit” and "21 - Increasing research -
eligible small business” to the "Code" field under Credits and credit recapture.

¥ Section for "Other Income/Deductions” is opened to C Corporation.
Extensions > Federal Extension

¥  We added the field "Print IRS mailing address on federal extension - (Y),(N) #" to the
"Extension Information” section.

Credits > 8827 > Credit for Prior Year Minimum Tax

¥  We added the fields "Section 383 Minimum Tax Credit Computation” and "Section 384
Minimum Tax Credit Computation.”

¥ We added the field "Form 3800, Line 38 Credit Allowed for Current Year" to Credits >
Credits Summary the General Business, Other & Patrons’ Credits.

Credits > Forms 5884, 6765, 8820, 8844, 8845, 8923 and 8932 - Employment Credits
¥ We added the field "Explanation for Current Year Credit Differing from Deduction.”
Credits > 6765 > Credit for Increasing Research Activities

¥ We added the fields for Eligible small business, Qualified small business electing payroll
tax credit, and Portion of Line 36 elected as payroll tax credit.
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Credits > 3468 > General

¥ We added the field "Section 1.48(h)(2)(viii) Adjusted Basis of Building Statement” to the
"Form 3468 - Other Information” section.

Credits > 8586 and 8609 > Low Income Housing Credit > Detail

¥ We added the fields "Qualified basis of low income building - override” and "X to Pro
Forma qualified basis of low income building."

Credits > 8941

¥  We added the field "X if you filed a tax return for tax year 2014 and also included a Form
8941 with Line A checked 'Yes' and Line 12 showing a positive amount.”

Taxes > Personal Holding Company Tax > Testing for Exclusions to PHC Income

¥ We added this section for tests added to automatically check for exclusions of items from
PHC income.

Taxes > Recapture of Investment Credit

¥  We changed the "Cost” in the "Form 4255 - Tax From Recomputing A Prior Year
Investment Credit” section to "Credit Base - Previous Tax Year."

¥ We added columns for "Net Change in Nonqualified Nonrecourse Financing,” "Credit Taken
on Form 3800 in Prior Years," "Unused GBC Would Have Been Allowed," and "Unused GBC
Would Have Been Allowed Had There Been No Credit.”

¥ o Input field "Computation for the Recapture of Qualifying Therapeutic Discovery Project
Grant for Form 4255, Line 10" has been added.

Common State > Allocation and Apportionment - Total Everywhere Overrides

¥ We added the field "X to Pro Forma Total Everywhere Override next year." Check the field
to foll forward total everywhere override information entered on Common State >
Allocation and Apportionment - Total Everywhere Overrides > Options through
Transportation Factor.

Common State > State/City Common Data > Principal Business Address/Firm Information

¥ We added the fields "Province” and "Foreign country” to the "Firm Information or Location
of Books if Diff than Fed - Override” section.

Other > 1128
¥ We added input to prepare Form 1128.
Other > 1139 > Computation of Decrease in Tax
¥ We added the field “Exclude carryback” to exclude the net operating loss carryback to a
specific year.
Other Returns > 1120-H-Homeowners Association > General

¥ We added the fields "X to include property acquisitions in expenditures for 90% test" and

"Acquisitions of personal and real property - override.”
Other Returns > 1120-F

¥ We added the field "X if the corporation is claiming treaty benefits pursuant to a
Competent Authority determination” to Other Returns > 1120-F > General.

¥ We added fields "Disallowed passive interest expense - override” and "Deferred passive
interest expense allowed - override” to Other Returns > 1120-F > Schedule | - Interest
Expense Allocation Under Regs. Sec. 1.882-5.

¥ Use field "Chapter indicator” on Other Returns > 1120-F > Form 1042-S - Foreign Person’s
US Source Income Subject to indicate whether the amounts were withheld (or paid by the
withholding agent) pursuant to chapter 3 or chapter 4.
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¥ We added the field "LOB code” to the "Recipient's Information” section on Other Returns >
1120-F > Form 1042-S - Foreign Person’s US Source Income Subject to.

¥ We added the fields "Chapter 3 status code” and "Chapter 4 status code” to the
"Intermediary and Other Information” section.

# Use Other Returns > 1120-F > Form 8805 to prepare Copy C of Form 8805 and Other
Returns > 1120-F > Form 8288-A to prepare Copy B of Form 8288-A.

Consolidated/Combined Returns

Consolidated Members' NOL Pro Forma Adjustments

2015 consolidated NOL adjustments will not automatically be taken into account when a consolidated
member company’s roll forward is processed in 2016. In the past, each separate member’s NOL pro formaed
input had to be manually adjusted for any prior year consolidated differences to be properly reflected in the
member company’s 2016 NOL calculation.

To help automate this process, two grids "Member Companies' NOL Pro Forma Adjustments” and "Member
Companies’ AMT NOL Pro Forma Adjustments” were created. There is a summary of the application of the
Net Operating Loss carryover on the consolidated return. These summary grids provide a detailed
comparison of each member’s separate company NOL carryover to the consolidated NOL carryover
attributed to it, and show the adjustment, if any, that needs to be made to member's company 2016 roll
forward to reflect any 2015 consolidated NOL adjustments.

They may be exported to a Microsoft® Excel® spreadsheet in the 2015 consolidated tax return and then
imported to the same grid in a member company’s 2016 tax return. Once this is done, you may elect to
have the program use these adjustments to calculate the member’s company current year NOL deduction.
Your original 2016 rolled forward input will remain unchanged.

Importing these spreadsheets alone to a 2016 consolidated member's return will not cause the automatic
update to be performed. To select this automatic update option, mark the "Adjust this non-consolidated
company’s NOL pro forma based on its prior year consolidated membership” field on Export > Consolidated
Members' NOL Proforma Adjustments > Option to Adjust Member Companies' Pro Forma. For more
information, see help.

Temporary Difference Column Added to Consolidated Schedule M-3 Workpapers

This column has been added to the 1120/1120-L/1120-PC Consolidated Schedule M-3 for Income (Loss) Items
workpapers; 1120/1120-L/1120-PC Consolidated Schedule M-3 for Expense/Deduction Items workpapers; and
Consolidated Schedule M-3 Attachment (Form 8916-A) workpapers. Workpapers will now cross foot (columns
(a) + (b) + (c) = column (d)). Due to laser mask size constraints only the consolidated amount column was
added.

States

B We added the ability to e-file state estimate payments for:
Minnesota New York City Tennessee
B We added Form 8879-S0O, State Signature Forms for:

Alaska Nebraska
Connecticut New Jersey
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Delaware New Mexico

Florida North Carolina
Idaho North Dakota
Illinois Rhode Island
Kansas Tennessee
Maine Texas

Michigan Utah
Minnesota West Virginia
Missouri Wisconsin
Montana
B We added State/City electronic filing for:
# C(California Extensions - Stand Alone EFW Payments
¥ Detroit
% District of Columbia
¥ Nebraska
¥ New Hampshire
¥ New York City Combined corporation

New Consolidated/Combined State Forms
The following forms can now be processed:

B New York Mandatory First Installment (MFI) of Estimated Tax for Corporations (Form CT-300)

B New York Eligible Employee Information for the Minimum Wage Reimbursement Credit (Form
CT-639-ATT)

California
We added the following:

® California Resident and Nonresident Withholding Tax Statement (Form 592-B)
® (California Real Estate Withholding Tax Statement (Form 593)

Connecticut
We added the following:

& CT-1120A-CU - Apportionment Computation for Combined Unitary Filers
CT-1120CU-MI - Combined Group Member Information

CT-1120CU-MTB - Tax on Combined Group Minimum Tax Base
CT-1120CU-NCB - Nexus Combined Base Tax Calculation

CT-1120CU-NI - Tax on Combined Group Net Income

CT-1120CU - Combined Unitary Corporation Business Tax Return
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Michigan- Detroit

We added the following:

Nevada

Form 5297 -
Form 5298 -
Form 5299 -
Form 5300 -

Form 5301

City of Detroit Corporate Income Tax Return

City of Detroit Corporate Renaissance Zone Schedule
City Corporate Income Tax E-file Payment Voucher

City of Detroit Corporate Income Tax Quarterly Voucher

- Application for Extension of Time to File City Corporate Income Tax Return
Form 5324 -

City of Detroit Corporate Income Tax Penalty and Interest Computation for

Underpaid Estimated Tax

We added the Nevada Commerce Tax (Summer 2016).

New York

We added the following:

B New York Mandatory First Installment (MFI) of Estimated Tax for Corporations (Form CT-300)
B New York Eligible Employee Information for the Minimum Wage Reimbursement Credit (CT-

Ohio

639-ATT)

We removed the following:

® Form CAT-12

B Form FIT-10

Oklahoma

We added 504-C, Application for Extension of Time to File.

Rhode Island
We added 2D barcodes.

Wisconsin

We added Schedule BD, Business Development Credit.
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S Corporation (1120S) Product Enhancements

Return to Table of Contents.

Federal

Form 1128

Form 1120, Application to Adopt, Change, or Retain a Tax Year, is prepared from input on Other > 1128 >
Part I, General Information through Part Ill, Ruling Request.

Form 7004

You can select the new option “Print IRS mailing address on federal extension” on Extensions > Federal
Extension > Line 17, to Print the IRS mailing address at the bottom of Form 7004. A return configuration set
option is also available.

Form 8830

We added the Enhanced Oil Recovery Credit form back to the program.

Banking “Confirm” Option

This option is now required for all electronic filing returns. Previously it would only disqualify if the return
results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate bank
account information (Summer 2016).

Schedule D, Part IV

We added Part IV to Page 2 devoted solely to timber gain tax. The qualified timber gain is calculated from
detail entries on Income/Deductions > Gain and Losses with property type “CAP,” “1231,” “1245,” or
“1250” and Schedule D Options of “20.” Use General > Basic Data > Miscellaneous Information > Qualified
timber gain - override.

Schedule D/ Form 8949
We added input for “Quantity” of shares.

Schedule M-3

We added Schedule M-3 designation codes “SL,” “AC,” and “SA” for rental and farm activities.

Schedule M-3, Part Il, Lines 1 through 8

We now produce a supporting statement for each of the Lines 1 through 8 on Part Il.

Carryover Information Suppression

The General Carryover Data report and the Detail Carryover Schedule will be suppressed when the option to
“Suppress Pro Forma Processing” is selected on General > Return Options > Pro Forma Options > Suppress Pro
Forma processing.
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Depreciation Detail Reports

We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font” Depreciation
Detail reports remain and are renamed Depreciation Detail.

Other Input Changes

B General > Basic Data > Miscellaneous Information

¥ We added the fields “Qualified timber gain - override” and “X if the corporation made
any payments that would be required it to file Forms 1042 and 1042-S under chapter 3 or
4.”

B General > Basic Data > State Information

¥ We added fields to enter 50% and 100% bonus depreciation taken in 2015 and Section 179
deduction taken in 2015. These fields are for state use only.

B General > Letter and Filing Instructions > Transmittal Letter
¥ We added the field “Do not prepare separate letters for certain federal forms.”
B General > Letters and Filing Instructions > Miscellaneous Options and Overrides
¥ We added the section “Federal Filing Address Overrides.”
B General > Depreciation and Depletion Options - Overrides

¥  We removed the fields "Code for depreciation reports: Landscape (1), Portrait (2), Small
font (3)" and "Section 179 carryover from passthrough entities” from the "Depreciation
Options" section.

® General > Electronic Filing > General
¥ We expanded and separated "General Information” into eight sections.

® Foreign > 114/8938 > Form 8938 Part Il - Asset and Foreign Stock Information
¥ We added a column for “GIIN Number.”

® Foreign > 114/8938 > 8938 Closely Held Owner Information
¥ We added the section “Ownership Information.”

® Foreign > Foreign Operations of US Corporations

¥ We added the field "Valid statement if the corporation was a specified domestic entity
required to file Form 8938."

® Income/Deductions > Gains and Losses
¥  We added a column for “Quantity.”
® Income/Deductions > Section 179/280 Recapture, 4684 ELF
¥ We added a section “4684 ELF Information.”
B |ncome/Deductions > Like-Kind Exchange > Supplemental Information 1

¥ We added "Realized and Recognized Gain in Multi-asset Exchange” to the bottom of the
form.

® Income/Deductions > Domestic Production Activity Deduction other Information >
Override

¥  We added the fields "Total cost of goods sold from all activities - All Activities” and "Total
cost of goods sold from all activities - Oil-Related Activities.”

® Income/Deductions > Rent and Royalty > General
¥  We added the field "Schedule M-3 Designation Code."
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Income/Deductions > Business > Other Deductions > Extraterritorial Income Exclusion
from Form 8873 > Detail

¥ We added the fields "X to Pro Forma" and "Basis for Entitlement Statement” to the bottom
of the form.

Income/Deductions > Dividends

¥ We added columns for payers address.
Income/Deductions > Farm/4835

¥ We added the field "Schedule M-3 Designation Code."
Income/Deductions > Fiduciary Passthrough

¥ We added the field "Class code” to the "Schedule K-1" page.

¥ We added the fields "Apportionable cost of goods sold - Qil-Related Activities" and
"Apportionable cost of goods sold - All Activities.”

# Section for "Other Income and Deductions” is opened to C Corporation.

¥ We added the field "Apportionable cost of goods sold” to the State columns.
Income/Deductions > Partnership Passthrough

¥ We added the field "Class code” added to the "Schedule K-1" page.

¥ We added the fields "Apportionable cost of goods sold - OQil-Related Activities" and
"Apportionable cost of goods sold - All Activities.”

# Section for "Other Income and Deductions” is opened to C Corporation.

¥ We added the field "Apportionable cost of goods sold” to the State columns.

¥ The field "Comm revit/disaster area ded from RRE act” is opened to C Corporation.
Income/Deductions > Partnership Passthrough or Fiduciary Passthrough

¥ We added codes "20 - Enhanced oil recovery credit” and "21 - Increasing research -
eligible small business” to the "Code” field under Credits and credit recapture.

# Section for "Other Income/Deductions” is opened to C Corporation.
Extensions > Federal Extension

¥ We added the field "Print IRS mailing address on federal extension - (Y),(N) #" to the
"Extension Information” section.

Credits > 8827 > Credit for Prior Year Minimum Tax

¥ We added the fields "Section 383 Minimum Tax Credit Computation” and "Section 384
Minimum Tax Credit Computation.”

¥ We added the field "Form 3800, Line 38 Credit Allowed for Current Year" to Credits >
Credits Summary the General Business, Other & Patrons’ Credits.

Credits > Forms 5884, 6765, 8820, 8844, 8845, 8923 and 8932 - Employment Credits
¥ We added the field "Explanation for Current Year Credit Differing from Deduction.”
Credits > 6765 > Credit for Increasing Research Activities

¥ We added the fields for Eligible small business, Qualified small business electing payroll
tax credit, and Portion of Line 36 elected as payroll tax credit.

Credits > 3468 > General

¥ We added the field "Section 1.48(h)(2)(viii) Adjusted Basis of Building Statement” to the
"Form 3468 - Other Information” section.

Tax Product Enhancements « 32



Credits > 8586 and 8609 > Low Income Housing Credit > Detail

¥ We added the fields "Qualified basis of low income building - override” and "X to Pro
Forma qualified basis of low income building."

Credits > 8941

¥ We added the field "X if you filed a tax return for tax year 2014 and also included a Form
8941 with Line A checked 'Yes' and Line 12 showing a positive amount."

Taxes > Personal Holding Company Tax > Testing for Exclusions to PHC Income

¥ We added this section for tests added to automatically check for exclusions of items from
PHC income.

Taxes > Recapture of Investment Credit

¥ We changed the "Cost" in the "Form 4255 - Tax From Recomputing A Prior Year
Investment Credit" section to "Credit Base - Previous Tax Year."

¥ We added columns for "Net Change in Nonqualified Nonrecourse Financing,” "Credit Taken
on Form 3800 in Prior Years," "Unused GBC Would Have Been Allowed," and "Unused GBC
Would Have Been Allowed Had There Been No Credit."

¥ o Input field "Computation for the Recapture of Qualifying Therapeutic Discovery Project
Grant for Form 4255, Line 10" has been added.

Common State > Allocation and Apportionment - Total Everywhere Overrides

¥ We added the field "X to Pro Forma Total Everywhere Override next year.” Check the field
to foll forward total everywhere override information entered on Common State >
Allocation and Apportionment - Total Everywhere Overrides > Options through
Transportation Factor.

Common State > State/City Common Data > Principal Business Address/Firm Information

¥ We added the fields "Province" and "Foreign country” to the "Firm Information or Location
of Books if Diff than Fed - Override” section.

Other > 1128
¥ We added input to prepare Form 1128.
Other > 1139 > Computation of Decrease in Tax
¥ We added the field “Exclude carryback” to exclude the net operating loss carryback to a
specific year.
Other Returns > 1120-H-Homeowners Association > General

¥  We added the fields "X to include property acquisitions in expenditures for 90% test" and
"Acquisitions of personal and real property - override.”

Other Returns > 1120-F
¥  We added the field "X if the corporation is claiming treaty benefits pursuant to a
Competent Authority determination” to Other Returns > 1120-F > General.

¥ We added fields "Disallowed passive interest expense - override” and "Deferred passive
interest expense allowed - override” to Other Returns > 1120-F > Schedule | - Interest
Expense Allocation Under Regs. Sec. 1.882-5.

¥ Use field "Chapter indicator” on Other Returns > 1120-F > Form 1042-S - Foreign Person’s
US Source Income Subject to indicate whether the amounts were withheld (or paid by the
withholding agent) pursuant to chapter 3 or chapter 4.

¥ We added the field "LOB code” to the "Recipient's Information” section on Other Returns >
1120-F > Form 1042-S - Foreign Person’s US Source Income Subject to.
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¥ We added the fields "Chapter 3 status code” and "Chapter 4 status code” to the
"Intermediary and Other Information” section.

¥ Use Other Returns > 1120-F > Form 8805 to prepare Copy C of Form 8805 and Other
Returns > 1120-F > Form 8288-A to prepare Copy B of Form 8288-A.

Consolidated/Combined Returns

Consolidated Members' NOL Pro Forma Adjustments

2015 consolidated NOL adjustments will not automatically be taken into account when a consolidated
member company’s roll forward is processed in 2016. In the past, each separate member’s NOL pro formaed
input had to be manually adjusted for any prior year consolidated differences to be properly reflected in the
member company’s 2016 NOL calculation.

To help automate this process, two grids "Member Companies' NOL Pro Forma Adjustments” and "Member
Companies' AMT NOL Pro Forma Adjustments” were created. There is a summary of the application of the
Net Operating Loss carryover on the consolidated return. These summary grids provide a detailed
comparison of each member’s separate company NOL carryover to the consolidated NOL carryover
attributed to it, and show the adjustment, if any, that needs to be made to member's company 2016 roll
forward to reflect any 2015 consolidated NOL adjustments.

They may be exported to a Microsoft® Excel® spreadsheet in the 2015 consolidated tax return and then
imported to the same grid in a member company’s 2016 tax return. Once this is done, you may elect to
have the program use these adjustments to calculate the member’s company current year NOL deduction.
Your original 2016 rolled forward input will remain unchanged.

Importing these spreadsheets alone to a 2016 consolidated member's return will not cause the automatic
update to be performed. To select this automatic update option, mark the "Adjust this non-consolidated
company’s NOL pro forma based on its prior year consolidated membership” field on Export > Consolidated
Members' NOL Proforma Adjustments > Option to Adjust Member Companies' Pro Forma. For more
information, see help.

Temporary Difference Column Added to Consolidated Schedule M-3 Workpapers

This column has been added to the 1120/1120-L/1120-PC Consolidated Schedule M-3 for Income (Loss) Items
workpapers; 1120/1120-L/1120-PC Consolidated Schedule M-3 for Expense/Deduction Items workpapers; and
Consolidated Schedule M-3 Attachment (Form 8916-A) workpapers. Workpapers will now cross foot (columns
(a) + (b) + (c) = column (d)). Due to laser mask size constraints only the consolidated amount column was
added.

States

B We added the ability to e-file state estimate payments for:
Minnesota New York City Tennessee
B We added Form 8879-SO, State Signature Forms for:

Alaska Nebraska
Connecticut New Jersey
Delaware New Mexico
Florida North Carolina
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Idaho North Dakota

Illinois Rhode Island
Kansas Tennessee
Maine Texas

Michigan Utah
Minnesota West Virginia
Missouri Wisconsin
Montana
B We added State/City electronic filing for:
# C(California Extensions - Stand Alone EFW Payments
¥ Detroit
% District of Columbia
¥ Nebraska

¥ New Hampshire

New Consolidated/Combined State Forms

The following forms can now be processed:

® New York Mandatory First Installment (MFI) of Estimated Tax for Corporations (Form CT-300)

® New York Eligible Employee Information for the Minimum Wage Reimbursement Credit (Form
CT-639-ATT)

New State Forms

The following forms can now be processed:

California Resident and Nonresident Withholding Tax Statement (Form 592-B)

California Real Estate Withholding Tax Statement (Form 593)

New York Mandatory First Installment (MFI) of Estimated Tax for Corporations (Form CT-300)
New York Eligible Employee Information for the Minimum

Arkansas

We added additional supporting statements to Arkansas Schedule K-1.

Georgia
We added Form G-7 NRW, Nonresident Withholding Return (Summer 2016).

Idaho

We added a support statement to Form 41S, Idaho S Corporation Income Tax Return, for Other Items.

Maine
We added Form 1099ME, Pass-Through Withholding.
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Michigan- Detroit
We added the following:

Nevada

Form 5297 -
Form 5298 -
Form 5299 -
Form 5300 -
- Application for Extension of Time to File City Corporate Income Tax Return
Form 5324 -

Form 5301

City of Detroit Corporate Income Tax Return

City of Detroit Corporate Renaissance Zone Schedule
City Corporate Income Tax E-file Payment Voucher

City of Detroit Corporate Income Tax Quarterly Voucher

City of Detroit Corporate Income Tax Penalty and Interest Computation for

Underpaid Estimated Tax

We added the Nevada Commerce Tax (Summer 2016).

New York

We added the following forms:

B New York Mandatory First Installment (MFI) of Estimated Tax for Corporations (Form CT-300)
B New York Eligible Employee Information for the Minimum Wage Reimbursement Credit (CT-

Ohio

639-ATT)

We removed the following:

® Form CAT-12

B Form FIT-10

Oklahoma

We added 504-C, Application for Extension of Time to File.

Wisconsin

We added the following:

& Schedule BD, Business Development Credit
B Schedule MT, Alternative Minimum Tax
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Fiduciary (1041) Product Enhancements

Return to Table of Contents.Federal

Federal

Depreciation Detail Reports

We removed the Portrait and Large Font Depreciation Detail reports. Only the “Small Font” Depreciation
Detail reports remain and are renamed Depreciation Detail.

Banking “Confirm” Option

This option is now required for all electronic filing returns. Previously it would only disqualify if the return
results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate bank
account information (Summer 2016).

Miscellaneous

B We reorganized Electronic Filing input and created consistency across systems.
& Asset Description is static for summary grid scrolling purposes.

® Depreciation Department Number is now four characters (was two)
(1040/1041/1120/11205/1065).

B We added the 8879-S0 (state only) for states without a signature form
(1041/1120/11205/1065).

B We added the ability to file Form 8865 from a 1041 return.

B We added the ability to randomly generate the ERO PIN for 1041 returns like we do for 1040
returns.

Letters

B We added separate filing instructions and transmittal letters for these items to be used in future
print packages - 2848, 8879, 3520, and 3115 (1041/1120/1120S/1065).

B We added "amended” to the form description on the letters for amended returns.

B We added “Mail To:” and the mailing address to print at the bottom of extension and estimates,
7004, 8868. This will not print if the return is selected for electronic filing.

® We adjusted all letters and forms for the new Federal (and state) due dates for extended
returns.

Extensions

We moved the “Extensions” section to its own category; this is now the second item on the menu.

Federal Links Worksheet

We added “Autoflow” and "Date Calculated” to the worksheet to be easily used in DataScan.
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Drill Downs

We continue adding drill downs for major forms:

® Form 8960, Net Investment Income Tax, Line 19a - Adjusted gross income
B Schedule B, Interest and Ordinary Dividends, Line 10, Additional modifications (time available)

ESBT

We added a QPAI schedule under the ESBT menu (which corrected an issue with the regular
QPAI schedule including ESBT amounts).

B We changed the treatment of qualified dividend netting on 4952 to match 1040.

Consistency/Usability Initiative Changes

We added IRS Form names to menu for search ability.

B We revised the menu for logic and consistency.

B We moved Extension in the menu to second after General.

B We added summary grids to State Estimate Payment and State Extension Payment sections.

Organizer

You can now alphabetize K-1s on Organizers. The default is to alphabetize.

States

Nonresident state returns are automatically included for e-filing, when applicable for resident credit for
taxes paid.

We added e-file for:

Delaware
Rhode Island
South Carolina
Virginia

Arizona
We added the following:
& 8879-F, Efile Signature Authorization
® Form 141AZ V - Payment Voucher
Arkansas
We added the following:

B AR1000TC, Schedule of Tax Credits
B AR4-FID, Interest and Dividend Schedule
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California

® Amended returns and extensions can now be filed electronically.

B We added CA 8453-FID (PMT) - Payment for Automatic Extension and Estimate Payment
Authorization for Fiduciaries.

B We added CA 8879(PMT) - Electronic Funds Withdrawal Payment Signature Authorization for
Individuals and Fiduciaries.
Connecticut
We added the following:

® (CT-1041 Reminder Sheet, Checklist for Filing your Return
® CT-1041V Reminder Sheet, Checklist for Filing your Electronic Filing Payment Voucher

District of Columbia

We added electronic filing estimates.

lowa

We added 1041 Schedule I, Alternative Minimum Tax - Estates and Trusts.

Kansas
We added K-41ES - Estimated Voucher.

Michigan
& We now calculate credit for income tax paid to other states entered based on the other state

tax rate.

B We added a statement on Form MI 1041 to show the calculation for the credit on Line 14a and
Line 14b.

Nevada

We added the Nevada Commerce Tax (Summer 2016).

New York
We added the following:

® Form IT-217, Claim for Farmers’ School Tax Credit

Form IT-135, Sales and Use Tax Report for Purchases of Items and Services
IT-112-R, Resident Credit

IT-225, NYS Modifications

IT-1099R, Summary of Federal Form 1099R Statements

Electronic filing estimates

North Dakota

We added electronic filing estimates.
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Ohio
We added IT K-1, Beneficiary’s Information.

Oklahoma
We added the following:

Oklahoma Electronic Filing (Summer 2016)

B Electronic filing estimates

® 504-C, Application for Extension of Time to File

® EF-V, Business Filers Income Tax Payment Voucher

Pennsylvania

We added supporting detail for PA RK-1, Line 6, and NRK-1, Line 4.

Texas
We added 05-158-B FINAL, Franchise Tax Report.

Wisconsin
We added the following:

® Schedule BD, Business Development Credit
B Electronic filing estimates
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Exempt Organization (990) Product Enhancements

Return to Table of Contents.

Federal

Banking “Confirm” Option
This option is now required for all electronic filing returns. Previously it would only disqualify if the return
results did not match the requested banking options.

Note: It is now a full indicator that the preparer has verified the correct options and accurate bank
account information (Summer 2016).

Federal Links Worksheet

We added "Date Calculated” to the worksheet to be easily used in DataScan.

Miscellaneous

B We reorganized electronic filing and created consistency across systems.
® Asset Description is static for summary grid scrolling purposes.
B | etters:

¥ We added separate filing instructions and transmittal letters for these items to be used in
future print packages - 114, 2848, and 3115.

¥ We added a new sentence to refer the reader to the Direct Deposit/Debit Report if that
report is included in the return.

B We moved “Extensions” from the “Other” category to its own category; this is how the second
item on the menu.

® You can now print the mailing address on the bottom of federal extensions for paper filed
returns. A return configuration set option is also available.

Consistency/Usability Initiative Changes

B We revised the menu for logic and consistency.
B8 We moved Extension in the menu to second after General.

States

Minnesota
We added the Charitable Trust Annual Report.
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Issues Addressed

Return to Table of Contents.

Issues for the following CCH Axcess™ Tax features are resolved and are now available:

® Signature block. The signature block now includes the state.

B Electronically filing parent and subsidiary returns. The option to "Push EF options to parent
and subsidiary returns” is now available. This option activates the following for the parent and
subsidiary returns:

Under General > Electronic filing

= Electronically file the federal return and enable electronic file for return types
selected

= File all states returns electronically
= Tax return is a superseded return
= Do not transmit federal return/extension at this time

® DataScan. We have resolved the issue with password protected returns not opening after
running a DataScan search. You can now run DataScan on any password protected return.
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